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Information

About Leila Gharani

Leila Gharani is a Microsoft Excel MVP & a bestselling online course 
instructor. She runs XelPlus.com an Excel resource site to help people gain 
the knowledge they need so they can create useful tools, solve problems and 
get more done. She has a YouTube channel under her name with more than 
200k subscribers.

Her background is: Masters in Economics, Economist, Consultant, Oracle 
HFM Accounting Systems Expert & Project Manager. Find out more here.
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How to Use the Notes

Use these course notes alongside the online course to review and 
revise each section of the course.

You can also print it out. Keep it handy and refer to it anytime the need 
comes.

Course Notes for Excel Essentials Course

These course notes are accompanying documentation for my online course 
Excel Essentials for the Real World. Please do not reproduce or transmit in 
any form without permission.

We (XelPlus e.U.) have taken every effort to ensure the accuracy of this 
manual.  In case you discover any discrepancies, please send us a quick email 
to: info@XelPlus.com.

https://www.xelplus.com/
https://www.xelplus.com/about-leila-gharani/


XelPlus.com

Course Road Map

3

START Quick Tour 
of Excel

Data Input & Hidden 
Features to Save Time

Excel 
Formulas

Important Excel 
Functions

Data Cleaning & 
Management

Formatting incl. Conditional 
& Number Formatting

Printing Files & 
Saving as PDF

Workbook Design 
Principles

Working with 
Charts

Quick Insights with 
Pivot Tables

Introduction to 
Power Query FINISH

Worksheet Navigation & 
Copying and Protecting



XelPlus.com

Table of Contents

4

Getting Started     ------- 5

Data Input Shortcuts & Tips     ------- 7

Shortcuts for Navigation    ------- 9

Protecting Files & Sheets    ------- 10

Essential Formula Rules    ------- 11

Excel Functions    ------- 14

Data Cleaning & Management Tools   ------- 19

Useful Formatting Tools    ------- 20

Printing Checklist    ------- 21

Save Time Formatting Reports   ------- 23

Chart Productivity Tips    ------- 24

Pivot Table Tips    ------- 25

Introduction to Power Query   ------- 27

Spreadsheet Design Principles    ------- 22



XelPlus.com

Excel Vocabulary
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Excel Terminology You’ll Need:

Workbook: An Excel file which includes one or more worksheets (tabs)

Worksheet:  A single page inside a workbook which consists of cells

Cell: The intersection of a column & a row is a cell 

Cell Address: Each cell has an address (e.g. C3, column= C, row=3)

Formula Bar: Shows the formula written in the selected cell or the cell value 
(if no formula is written)

Name Box: Shows the address of the selected cell

Range: A group of cells

Range Address: Starts from the top left-hand corner to “:” bottom right-
hand corner (e.g. C3:D6)

Selection Handle

Click to select one cell, drag selection to select a range 

Move Handle

Click and drag to move a cell or range

Fill Handle

Drag to fill the cell value to the other cells

Mouse Icons

Type a cell address in the name 
box to quickly jump to the cell
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Quick Tour of Excel
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Most Common Features For Every Tab

File: Also called Backstage View – Save, Open, Pin documents & Print

Home:  Formatting options as well as most common Excel features   

Insert: Insert Charts, Tables, PivotTables (Sections 11 & 12)

Page Layout: Prepare for Printing (Sections 9 & 10)

Formulas: Overview of Excel Functions (Section 6)

Data: Get & Transform Data (Section 13)

Review: Spell check, Protect worksheet (Section 4)

View: Remove Gridlines 

Developer: For Advanced Excel users who use VBA

Help: Get Help, provide feedback & suggest new features
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Data Input Shortcuts
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Double-click Format Painter 
to use it multiple times

Shortcut Key Action

[Enter] Move one cell down

[Ctrl] [Enter] Stay on the same cell

[Ctrl] C Copy cell / value

[Ctrl] V Paste cell / value

[F2] Edit cell content (same as double clicking 
on a cell)

[Esc] Reset cell value (while in edit mode)

[Tab] Move to the cell on the right

[ALT] [Enter] Add a line break inside the formula bar

[Ctrl] Z Undo action

[Ctrl] Y Redo action

[ALT] = Auto sum

Select [F2] [Ctrl] 
[Enter]

Copy formula down without formatting

[Ctrl]  ; Time Stamp current date

[Ctrl] [Shift] ; Time Stamp current time

[Ctrl]  # Change date formatting to D-MMM-YY

[Ctrl] E FlashFill

[Ctrl] N Open Blank Workbook

[Ctrl] G Go to Special

[Shift] [F2] Insert a note
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Input Faster & Validate Data
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Auto Fill For Index numbers, Weekdays, Months & more

If you’d like to get a list of months, type in the first month and drag the 
selection down. Check the auto fill options for more choices.

Flash Fill to Modify & Speed up Data Entry

Use Flash Fill to get a list of email address, split names to two columns or 
combine names from two columns into one. Just start typing or use the 
shortcut key Ctrl + E or go to Home / Fill / Flash Fill.

Go to Special to Find Special Cells

Use the shortcut key Ctrl + G then Alt + S to bring up Go to Special. 
Alternatively go to Home / Find & Select. Use this feature to quickly find 
formula cells, constants, comments and data validation.

Data Validation

Use Input Message 
as a screen tip tool.
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More Excel Shortcuts
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Shortcut Key Action

[Ctrl] [Page ▼] Move to the next worksheet

[Ctrl] [Page ▲] Move to the previous worksheet

[Ctrl] [Tab] Switch between Excel Workbooks

[Ctrl] [▼] Move to the bottom of the data region
Other arrow keys - move to the edge of the data 
region

[Ctrl] [Shift] [▼] Move to the bottom of the data region and 
highlight the range in between
Other arrow key to move & highlight in different 
direction

[Ctrl] A Select data in current region

[Home] Move to the first cell in the same row

[Ctrl] [Home] Move to cell A1

[Ctrl] [End] Move to the last used cell on the worksheet

[Ctrl] [Backspace] Show active cell

[Ctrl] O Open a workbook (Open menu)

[Ctrl] S Save a workbook

[Ctrl] W Close a workbook

[Shift] [F11] Insert a new worksheet

[Ctrl] [+] Insert a new cell/row/column

[Ctrl] [-] Delete a cell/row/column

[Shift] [Space] Select the row

[Ctrl] [Space] Select the column

[Ctrl] B Bold

[Ctrl] 1 Format cells dialog box

[F4] Repeat last edit
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Protect Your File & Sheets

10

Protect File with a Password

To protect your workbook with a password, go to 
Save As and from the Tools options, select General 
Options. Type in your password.

To be able to edit ranges with different 
passwords use Allow Edit Ranges from the 
Review Tab. 

Select a range and provide a different 
password for it. 

Once done, protect the sheet.

Protect the Structure of Your File

Protect the structure of your file from Review / Protect 
Workbook. This ensures the sheets are not moved, 
deleted or added. 

Protect the Sheet

Protect the sheet to ensure users cannot change formulas 
or input in cells they shouldn’t be inputting. 

To lock some areas but leave others open, go to Format 
Cells (Ctrl + 1) / Protection & remove the checkmark for 
locked.

What happens after you protect the sheet from the 
review tab:

The cells which didn’t have a checkmark will remain open. 
All other cells will be locked.
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Order of Calculations in Excel

Parenthesis ( ) & Reference Operators

Values in brackets and cell reference operators such as : and ,  
=SUM(A2:A4,B2:B4)

Negation -

For example -1*2 = -2

Percentage %

For example -1*2% = -1*0.02 = -0.02

Exponentiation ^

For example =2^2*2 = 8

Multiplication * & Division /

If both are present in the formula, Excel evaluates from left to right.

Addition + & Subtraction

If both are present in the formula, Excel evaluates from left to right.

For example 2+1*(3+1) = 2+1*4 = 2+4 = 6

Ampersand &

For example 1+2+3&3 = 63

Comparison = <  > <= >= <>

For example 1+2=1+2  = True

11
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MBA = Multiplication Before Addition
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Excel’s Essential Formula Rules

No Constants Inside Formulas

…Keep constants in separate cells with proper labeling so they can easily 
by adjusted if needed.

Exceptions are universal constants such as 24 hours in a day, 7 days a 
week, 12 months a year etc.

12

1

2 Formulas in a range should be consistent

Don’t adjust formulas in the middle of a range or remove them entirely if 
they result in an error. 

Update the first formula in the range to handle different scenarios (IF 
Function – covered in the next section) & include error handling (IFERROR 
or IF Function in case the result might be an error).
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Excel’s Essential Referencing Rules

Absolute, Relative or Mixed Referencing

Use F4 to toggle the cell reference between the different types.

= $A$1  →Reference to A1 will remain fixed.

= A$1  → Row 1 will remain fixed, but column will change.

= $A1  →Column A will remain fixed, but row will change.

= A1  → Both column and row will change.

13
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2 Connect Cell References

Use & to connect one cell reference with another.

For example: =A1&B1

3 Properly Use Text In Formulas

Use quotation marks to insert text in formulas. E.g. =“Hello”

If you combine a cell reference with text you need to use ampersand.

For example: =A1&" - "&B1

Mixed Referencing Example
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Important! Working with Functions

What is a Function?

An Excel function is an in-built formula that runs specific calculations. 

For the Excel function to work, you need to provide it with values in the 
order it understands. This means following the right syntax.
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Sum Function Example

The SUM function is programmed to add values from cells & ranges.

The suggestions you see inside the 
brackets when you type in a function 
is to help you understand what the 
function needs so it can process 
correctly. 

These are called arguments and they 
are separated by either the comma (,) 
or the semi-colon (;). 

Which one applies to you depends on 
your regional windows setting.

Excel Automatically Translates Functions & Regional Settings

Assume you have an English version of Excel. Your Excel argument separator 
is a comma. You create a spreadsheet with many formulas. 

You then send this to your colleague located in Germany. When they open 
the file, they will see the German version of the formulas and the argument 
separator is automatically adjusted to a semi-colon. 

In English the formula looks like this:

= SUM(A1:A2,B1:B2)

In German it will look like this:

=SUMME(A1:A2;B1:B2)
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Working with Date & Time

Inputting Dates Correctly

How dates are input depends on your locale / regional settings. 

• In US dates are input as MM/DD/YYYY

• In Europe they are generally input as DD/MM/YYYY

To ensure the date was input correctly look at the number formatting. If 
you see “Date” as format, Excel has correctly recognized the input.
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How Excel Remembers Dates

In Excel, dates are stored as a serial number starting from January 1st, 1900.

Jan 1, 1900 = 1

Jan 2, 1900 = 2

Feb 25, 2019 = 43521

The fact that Excel stores dates as numbers helps us make 
calculations on dates – for example:

2/25/2019 + 10 = 3/7/2019

How Excel Processes Time

Time is input as hour : minute : second followed by space then AM or PM. 
You can also input time as a 24-hour clock. 

7:00 PM or 19:00

In Excel, time is stored as a serial number which represents the proportion of 
24 hours. For example:

• 12:00 AM = 24:00 = 24/24 =1

• 6:00 PM = 18:00 = 18/24 = 0.75
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Important Excel Functions

Here is a list of some of the most used functions in Excel. 
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Function Description

COUNT 
COUNTA 
COUNTBLANK

Counts the number of cells that contain numbers
Counts the number of cells that are not empty
Counts the number of empty cells in a range of cells

COUNTIFS
This function applies criteria to cells across multiple ranges 
and counts the number of times all criteria are met.

SUM

AVERAGE

Adds individual values, cell references or ranges or a mix of 
all three.
Returns the average (arithmetic mean) of the arguments.

SUMIFS
AVERAGEIFS

Adds all its arguments that meet multiple criteria.
Returns the average (arithmetic mean) of all cells that 
meet multiple criteria.

MIN
MAX

Returns the smallest number in a set of values.
Returns the largest value in a set of values.

MINIFS

MAXIFS

Returns the minimum value among cells specified by a 
given set of conditions or criteria.
Returns the maximum value among cells specified by a 
given set of conditions or criteria.

ROUND
ROUNDUP
ROUNDDOWN

Rounds a number to a specified number of digits.
Rounds a number up, away from zero.
Rounds a number down, toward zero.

IF

Allows you to make logical comparisons between a value 
and what you expect. It can have two results. The first 
result is if your comparison is True, the second if your 
comparison is False.

VLOOKUP
Looks up a specified value in one column of data and 
returns the corresponding value from another column.
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NEW Excel Functions in Microsoft 365

Here is a list of some of the Essential NEW Functions available in 
Microsoft for Excel 365
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Function Description

UNIQUE Returns a distinct list of values. You can also return a list of 
values that only occur once in the data.

SORT & SORTBY
The Sort function sorts your values (text or numbers) in 
ascending or descending order. SORTBY, can sort your 
results based on a range that’s not in your end result.

FILTER
FILTER can return multiple results based on a condition. If 
you’d like to do a lookup and return ALL matches instead of 
the first match, you can now use the FILTER function.

XLOOKUP

XLOOKUP is the more flexible version of VLOOKUP. It can 
look up values to the left or the right of your lookup range. 
It can also return the last match instead of the first one. It 
can lookup values based on wildcards and approximate 
matches.
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Formula Errors

If your formula results in an error and you’re not sure why, the list below 
might help. 
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Error Description

#DIV/0! This is probably the most common error and easiest to 
pinpoint. When you divide a number by zero you will get this 
error.

#VALUE!
This error is returned when the wrong type of argument is 
used. For example if you try to multiply a value by a cell that 
has text in it.

#REF!

This error results when you move your formula, and haven’t 
correctly specified which cell references should be fixed and 
which should move with your formula. Also if you delete some 
cells that were a part of your formula.

#NAME?
The most common reason for this error is because the 
formula has been mistyped and Excel doesn’t recognize what 
function you are referring to.

#N/A!
This is a frequent error if you are using Lookup formulas 
(especially in VLOOKUP) and the matching cannot be done. 

#NULL!
This is an uncommon error and occurs if you haven’t specified 
your ranges correctly, e.g. typing SUM(B4 B6) instead of 
SUM(B4:B6) or SUM(B4,B6).

#NUM!

This is another uncommon error and occurs when you supply 
an invalid number to your formula e.g. if you are using 
negatives where a positive number is required by your 
function.

#SPILL

New Error only in Office 365 with Dynamic Arrays. If a spilled 
range is blocked by text or values in the cells below, then you 
get this error. The error can be corrected by removing the 
contents of the cells below.

#CALC
New Error only in Office 365 with Dynamic Arrays - common 
for the FILTER function when it can't find a match.
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Data Cleaning & Management Tools
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SORT DATA

Use the sort options to give order to your data. 

To sort more than one category use Custom Sort.  

FILTER DATA

Use shortcut key Ctrl+Shift+L to toggle the filter buttons on and 
off. You can copy, change and delete filter results.

FIND & REPLACE

Ctrl+F brings up the Find dialog box.

Ctrl+H brings up the Replace dialog box. 

REMOVE DUPLICATES

Use Remove Duplicates from the Data tab to get a list of unique 
values. Performing this on more than one column ensures you 
get a unique list based on the combination of values from the 
different columns.

GO TO SPECIAL

Go To Special from the Home tab (Shortcut key 
Ctrl+G or F5) can select specific cell types on a 
range or sheet.

Once selected you can perform the necessary 
action on all the cells in one go.

You can also search for a 
specific formatting and 
replace it with another one.

To copy a formula to more than 
one cell in one go, type the 
formula and then press 
Ctrl+Enter (instead of just Enter)
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Useful Formatting Tools
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Center Across Selection Instead of Merge

To center text or values on your report, use Center Across Selection 
from Format Cells Alignment Options instead of Merging. This makes it 
easier to write formulas, copy specific columns & maintain the report.

Fill → Justify

To fit long text or set of instructions to 
a specific number of cells in a column, 
select the range, go to Home / Fill / 
Justify

Number Formatting Options

Take advantage of the various number formatting options 
available under Format Cells (Ctrl+1). For example, use Special
Formatting to format phone numbers properly.

Conditional Formatting

Create conditional formatting rules, including 
adding dynamic icons and data bars to your 
reports. Take advantage of available built-in 
logic.
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Printing Checklist (Page Layout tab)
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CHOOSE THE RIGHT ORIENTATION

Is the report taller than wide? Go with Portrait. 

Is it wider than tall? Go with Landscape.

ADJUST THE MARGINS

Make the margins slightly narrower to be able to fit in more 
content on one page or allow for a higher scaling per page.

DEFINE PRINT AREA

Set a specific are to be printed by selecting the 
area first and then from Page Layout tab, select 
Print Area / Set Print Area

ADD A HEADER & FOOTER

In the Page Layout tab, click on the more 
features arrow. Go to the Header/Footer 
tab and add a custom header/footer.

REPEAT ROWS & COLUMNS (If needed)

Print Titles lets you select one or more rows & columns 
that you’d like repeated on each printed sheet.

PRINT PREVIEW BEFORE PRINTING

Add Print Preview & Print to your Quick Access 
Toolbar (QAT). If it’s missing from there, click on the 
arrow on the QAT and select Print Preview & Print. 
This will add it to your QAT.

Keep an eye on the scale to make sure 
resolution is high enough for the reader



XelPlus.com

Spreadsheet Design Principles
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INPUT SEPARATE FROM OUTPUT

Keep raw data on a separate tab to your final report.

DEFINE A PURPOSE FOR EACH SHEET

Each sheet should have a purpose. For example, the “report” tab is 
for final findings, the “calculation” tab organizes and prepares the 
data for the report tab.

HAVE CONTROL (SHEET)

Add a “control” sheet to record any changes you make to the 
structure of your file. Make sure you include time stamps.

ADD INSTRUCTIONS

Who will be using the file? Your colleagues? The client? Another 
department? Add a short explanation to describe how the file is 
organized. 

KEEP FILE BACKUPS

Make sure you take copies of your file from time to time. Specially if 
you’re revising formulas & values, keep a hard-coded version of your 
file (You can copy and paste special as values the data in the tabs).

PREPARE FOR PRINT 

Who are you sending or sharing the file with? Is there a chance they 
would print the file or save it as PDF? If yes, prepare it for print.

CONSISTENT COLOR CODING

Keep colors consistent throughout the report. If you have input 
fields that are a specific color in one tab, keep it the same across 
your sheets and workbooks. 

FORMAT FOR APPRECIATION

A little bit of formatting goes a long way. Keep your report organized 
with minimum formatting. This gives it a more professional look.
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Save Time Formatting Reports
Define Cell Styles

Take some time to define the cell styles you use most when you create 
reports. Do you use a specific header? A special format for input cells? Adjust 
the existing cell styles or create your own.

Create a Template

Once you’ve adjusted the cell styles, updated the workbook theme and any 
other adjustments you like to have as starting point when you open a new 
workbook, save the file as a template.

Before you do that make sure your workbook is empty (unless you require a 
specific setup or instructions you’d like to keep for every workbook)

You can also define a default style for Excel Tables.

Go to Save As – Save the workbook as 
.xltx

You can open the template by going to 
File / NEW.

Once you start working 
in the file and you want 
to save it, Excel will save 
it as a normal Excel 
workbook, i.e. xlsx file.
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Chart Productivity Tips

Shortcut to Insert your Default Chart

#1 – Select the data, then Alt + F1 ton insert the chart on the same sheet.

#2 – Select the data, then F11 to create a new chart sheet.

Turn your Source Data to an Excel Table

If you’d like to change your default chart 
from column to another type, e.g., Line 
chart: Go to Insert Chart dialog box, 
right-mouse click on the chart type you 
want and select Set as Default Chart.

To make it easier to spot which data 
point belongs to which category, create 
a manual axis directly under the 
sparklines. 

This works for fixed data points 
otherwise you’ll have to think of ways to 
make it dynamic with formulas.

If you’d like your chart to 
automatically include 
new values, turn your 
source data into an Excel 
table.

Add Your Own Axis to Sparklines

If you create a set of charts that need to stay together, 
make sure you group them. Select the charts by holding 
down Ctrl, right-mouse click & Group.

24



XelPlus.com

Working with Pivot Tables

- Which company sells the most?

- Which product generates the most sales?

- Which customer accounts for the highest % of total sales?

Get Quick Insights from Data

Pivot Tables Enable you to analyze your data (such as filter, sort, group, drill-
down) without writing complex calculations.

Checklist Before Creating a Pivot Table

✓ Make sure your data is in a Data List format

• Each column has a header (no blanks)

• No empty columns in your data table

• No summations embedded in your data table

✓ BEST method is to transform data to an Excel Table

• Ensures Pivot Table is updated when new data is added

• Ensures data is properly organized and each column has a header

25
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Tips for Pivot Tables
Use Tabular Design For Pivot Table Layout

Rename Pivot Headers

Instead of Sum of Quantity in the Pivot field header, change this to Quantity
and add a space character either before or after. 

Use Number Format Instead of Format Cells

Double-click on Values to Get the Full List

To get a list of each line of data making up the value shown on the Pivot 
Table, you can double-click the cell value. This creates a new sheet with all 
the rows of data that make up the aggregated value.

Remove the Check-mark for Autofit

One Pivot Table default setting that can get annoying is to automatically 
autofit the Pivot Table columns. 

In case you want this turned off, go to Pivot Table options: PivotTable 
Analyze > Options and un-check Autofit column widths on update.

To change the number format for the values 
in a Pivot Table, use Number Format instead 
of Format Cells.

This ensures the field keeps the formatting as 
the Pivot Table expands. 

To get the header for the category field on 
your Pivot Table report, use Tabular Design.

Go to Design Tab, Report Layout and select 
Show in Tabular Form.

26
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Why Use Power Query

Availability of Power Query

Since Excel 2016 Power Query is a part of Excel.

It’s called Get & Transform in the Data tab.

If you have Excel 2010 or Excel 2013 – you can use Power Query by 
installing the add-in from HERE (if you Google “Power Query add-in” 
download, you will find the official Microsoft site for downloading).
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Why Power Query?

If your raw data set is in another place, for example: another file, text file, 
the web etc. you can use Power Query to import and transform the data.

You can also use it for data in the same workbook. 

If you have a messy data set and you find it difficult to create formulas or 
a pivot table to analyze the data, Power Query can help you transform 
the messy data to a clean tabular data set.

https://www.microsoft.com/en-us/download/details.aspx?id=39379&CorrelationId=49ce0f00-fe9c-4092-b688-0a95d4a1d3bc
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THANK YOU!
Please take a few seconds to
leave a review for the course.
Your support is very much
appreciated.
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If you’d like to improve your Excel knowledge, check out my other 
courses:

Excel Dynamic Arrays Beginner to Expert

Master Excel Power Query: Beginner to Advanced (including M)

Unlock Excel VBA & Excel Macros

Visually Effective Excel Dashboards

Advanced Excel: Top Excel Tips and Formulas

Excel Charts: Visualization Secrets for Impressive Reports

Ultimate Excel Waterfall Chart Course

I share free content on YouTube every Thursday. My 
Channel is under my name.

More Learning…

You’ll find detailed blog posts and articles related to Excel 
and PowerPoint on my Website at www.XelPlus.com

https://www.youtube.com/Leilagharani
http://www.xelplus.com/

